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Overview

Introduction

Apogee Element Series User's Guide

Legendary Sound Quality. The Power of Thunderbolt. Elegant Simplicity.

Apogee’s Element 24, 46 and 88 are Thunderbolt audio I/O boxes for Mac. The Element Series takes the best of cutting-edge
Apogee gear like Symphony /O Mk Il, Ensemble Thunderbolt and Groove and puts it into simple form factors. With
streamlined hardware features and advanced software control, the Element series delivers ultimate recording quality and
performance at unprecedented prices.

The Elements of Excellent Audio
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Analog to Digital Conversion

A high-quality A/D converter is critical for capturing every detail of your recordings into your computer.
The Element series features some of the best Apogee A/D conversion. Recording through an Element
ensures you will minimize unwanted noise and maximize the signal quality. Your tracks will sound
amazing and mixing your project will be easier.

Microphone Preamps

Whether you are recording powerful drums, dynamic vocals or delicate strings, you need a premium mic
preamp to capture the finest details of the performance. The Element Series mic preamps feature
Apogee’s Advanced Stepped Gain Architecture™. This analog circuit is designed to dynamically
optimize across a gain range of 0-75dB to provide superior bandwidth and low distortion.

Digital to Analog Conversion

With a high-quality D/A converter, you will hear more definition in each track and virtual instrument. This
clarity makes it easier for you to make precise adjustments and achieve the ideal balance when mixing
your music. When you listen to your sessions through an Element, tracks will blend more harmoniously
and mixing will be easier. The high end will sound crisp and clear and the low end will be tight and well
defined.

Clocking

An audio interface relies on a clock source like an orchestra relies on a conductor. A digital audio clock
provides a timing signal to all the parts of a digital audio system so that each part of the AD/DA process
may be synchronized. Element has its own built-in clock source and provides professional Word Clock IN
and OUT for syncing with other digital audio gear. Use Element as the master clock to take advantage of
Apogee’s superior built-in clocking technology.

Thunderbolt Connectivity

The Element Series Thunderbolt driver offers incredible low-latency performance (1.41 ms round-trip)
and rock-solid stability. Apogee’s custom driver uses less of your computer's CPU power with the help of
Direct Memory Access (DMA) technology. This allows you to run more plugins and monitor through your
DAW at a low buffer setting. Element’s low latency driver means you don’t have to choose between
power and speed.



Apogee Element Series User's Guide

Package Contents

The following items are included with your Element Series Interface

Apogee Element 24 Apogee Element 46 Apogee Element 88
Universal Power Supply with Universal Power Supply with Rack mounting kit

standard 3 pin-IEC cable standard 3 pin-IEC cable Universal Power Supply with
Quick Start Guide Quick Start Guide standard 3 pin-IEC cable
Warranty Booklet Warranty Booklet Quick Start Guide

Warranty Booklet

Register your product

° Access Apogee’s expert Technical Support for free
) Receive important product update information by email
° Take the Customer Satisfaction Survey for a chance to win Apogee gear!

Register Now: www.apogeedigital.com/support/register

Element 24

Element 46

Element88 *'



http://www.apogeedigital.com/support/register
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Element 24 Panel Tour
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Setup

System Requirements

e Mac OS X 10.10 or greater
e Thunderbolt™-equipped Mac
e 4GB minimum RAM, 8GB Recommended

Download and Install Element Software package

Before Element will work with the computer, special software must be installed. Always get the latest version of the software
from the apogee website:

www.apogeediqgital.com/support/element

eo0e Element Installer

The download comes in the form of a .dmg file. Open it to view the contents.
Inside you will find three items:

e Element Release Notes.pdf

e  Element Uninstaller.app

e Element Installer.pkg

Element Uninstaller.app Element Installer.pkg

Double-click to launch the Element Installer.pkg. A dialog box will appear with a series of steps to proceed. Follow the
prompts to complete the installation. You will be required to restart your computer.

® B install Element Thunderbolt a ® B install Element Thunderbolt a
Welcome to the Element Thunderbolt Installer The installation was completed successfully.
Element Thunderbolt Audio Software Installer
Introduction Intreduction
System Requirements.
*  Mac OS X 10.10 or greater License
« Mac with Thunderbolt AR
* 4GB minimum RAM, 8GB recommended Destination Select
Installation Type
Installation The installation was successful.
Sumngy; The software was installed.
A A Click Restart to finish installing the software.
APOGEE ‘ APOGEE ‘
Continue i

As a result of the software install:
e  Element Control software is placed in the Mac’s Applications folder
e When connected, the Element Thunderbolt interface appears as an audio input/output device in Mac System
Preferences > Sound
e Element Firmware Updater.app is placed in the Mac’s Applications > Utilities folder.


http://www.apogeedigital.com/support/element

Apogee Element Series User's Guide

Connect Element to Your Computer

1. Connect the Power Supply to Element. 2. Connect Element to your Mac using a Thunderbolt cable.

If connecting a Second Element

1. Connect the Power Supply to Element

2. Connect Element to a second Thunderbolt port on your Mac.

3. Connect optical cables from the Optical Out of one Element, to the Optical In of the second Element.
e If second unit is Element 24 & 46 - Two optical cables required
e If connecting two Element 88 units - Four optical cables required

_
g,

Studio Monitors

Apogee Element 24, 46 or 88

Live Vocal
or Instrument

Headphones

Thunderbolt

ADAT MAC
9 J

Apogee Element 24, 46 or 88

Live Vocal
or Instrument
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Update Element’s Firmware

When first connecting Element to your computer, you may be prompted to update the Firmware:

® O Firmware Mismatch

Firmware for Element46 does not match installed software.
Please run Firmware Updater.

Update Not now

1. Click Update, or manually open the Element 2. Make sure only one Element is connected to the
Firmware Updater.app from your computer’s Mac. Then click Start Update.
Applications > Utilities folder.

Element Firmware Updater

e0e [59 utilities
< i =[] @ (%] S T Q Search
- R B Activity Monitor.app i
[ Docume... | 5 pagas.app armort Ut ty.mp Hardware Versions For Element46
Downloa.. = Photo Booth.app  ApogeeRegistration.app .
° # Photos.app B Apple Loops Utility.app Q Firmware: 0.2.13
[ Deskiop Preview.app M Audio MIDI Setup.app FPGA: F
£} apogee Pro Tools.app B3 Avid DigiTest 3 Element Firmware
A Applicat @ QuickTime Player.app & Bluetooth Fil..xchange.app Updater.a
Plcat- {1 Reminders.app 1% Boot Camp Assistant.app P . :,E?ME
@ AiDrop @ Safari.app % ColorSync Utilty.app — }::mma;
Stickies.app B Console.app i
bavces @ system preterencesze @ Digtal olor Meteropp oMl Tose. 215 i Updater Versions For Element46
[2) Mountai.. ! Textdit.app & Disk Utility.app Vet 0213 .
) The Unarchiver.app add Toga, s (50
Shared @ Time Machine.app ¥ Grab.app FPGA: F
A
3. Follow any prompts that may appear. 4. When it says Element is up to date, you can quit

the updater.

Elements Firmware Updater

Element Firmware Updater

Hardware Versions For Element46

Disconnect the Thunderbolt cable from Elements Firmware: 0.3.6

FPGA: F

Updater Versions For Element46

Firmware: 0.3.6
FPGA: F

T —— Qut SemeTS R e oA paste eakted,
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Element Control

Control of your Apogee Element Thunderbolt interface is available through a Mac software app, an iOS control app, or the
Remote control surface. Each provides it's own unique set of controls and features.

Element Control Mac Software

When Element Control for Mac software is opened, you are presented with a Snapshot Template chooser.

[ ] Snapshot Templates

Apogee Element Control
Choose a Template to get started

This template sets up Element Control for Direct Monitoring.

s are routed directly to hardware outputs through

Each Snapshot Template is a starting point that provides the most common feature set needed for various workflows. These
default Snapshot Templates and examples of their use are explained further on page 24. A snapshot can be customized to
your specific needs and saved as a user-snapshot. Here is an explanation of all the features and components of Element

Control Software:

Element Control consists of four windows:
1. Essentials
2. Primary
3. Hover Help
4. Remote
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Essentials Window

This window provides simple and compact controls for Input Channels and Outputs. It's orientation can be changed between
vertical and horizontal so that it can be placed to the side or end of your recording software.

2 _ 3

Element46 Analog 1 Analog 2 Analog 3 Analog 4 HP1 HP2 Main

Mic Mic Playback 1-2 @ d  Playback1-2 {4 | Playback1-2 | [§)

o) ([0} [0} o) [

1. Orientation Button - Switches the Essentials window between horizontal and vertical view.
2. Analog Input Channels - Provides settings for the analog inputs.
e The buttons at the bottom correspond to the Input Channel Settings: Phantom Power (48V), Group (G), Soft
Limit (SL), and Polarity Invert (o)
3. Outputs - Headphones and speaker outputs settings are provided.
e The buttons at the bottom correspond to the Output controls: Mute (M), Dimminish (D), Sum-to-Mono (%)
4. Clear Meters - Clear the Peak or Hold indicators from the level meters.
5. Talkback - Engages talkback to communicate with artists wearing headphones. Set the Talkback source and

destination in the System Sidebar.
6. Mute All - Mutes Headphones and Speakers outputs of the Element Thunderbolt interface. To unmute, click the

individual headphone or speaker mute buttons.

Primary Window

All features and settings of the Element Thunderbolt interface can be controlled from the Primary window. It is broken down

into several sections:
Tool Bar

Avcdog2  Amclog3  Amalogd  Opical12  Opical3d  Opicul6  Opical 7.6  Plajoack 12 Playback3-d Playback5-6  Playback 7-8  Playback 9-10

System

Sidebar = @ @ @

Device
Sidebar

Monitor/Output
Section

Mixer Section

10
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Tool Bar

The Tool Bar is always visible at the top of the Primary window. It provides the ability to show/hide the System Sidebar, Device
Sidebar, Essentials window, Remote window and Hover-Help window. It also has buttons for Clear Meters, Talkback and Mute
All outputs.

Clear Meters Button
Talkback Button
Mute All Button
Hover Help Button

System Sidebar Button
Device Sidebar Button
Essentials Button

Remote Button

HooN~
® N O

System Sidebar

Provides System-wide settings that apply to your recording system as a whole.

1. System Status Display - This displays the status of the connected hardware.
e Green - System is ready: Hardware is connected and recognized, and the digital
clock is locked to the Clock Source.
= e Red - System not ready. Either the hardware is not connected, or the system is not
Element46
locked to the Clock Source.
2. Master Device - When two Element interfaces are connected, select one as the Master
Device. The Master Device acts as the clock master, is listed first in your DAW’s hardware
I/0 assignment, and includes Output Format functionality on the Main outputs.

Internal

192kHz
3. Clock Source - Selects the system clock source for Element. The following sources may
be selected:
e Internal: Element is clocked from its internal crystal
e Word Clock: Element is clocked from an external word clock signal connected to the
rear panel BNC input
e Optical: Element is clocked from a digital audio input.

2 seconds

4. Sample Rate - Selects Element’s sample rate. In some cases this setting may be

Built-in Microphone overridden by software running on the computer (i.e. When a DAW session project is
open).

5. Peak Hold - Sets the time that peak indications are held on the level meters.

6. Over Hold - Sets the time that over indicators are held on the level meters.

7. Talkback Source - Select the source of the Talkback Signal. If your Mac is equipped with a
Built-in Mic, select Built-in Mic as the source.

8. Talkback Destination - Set the Playback channel destination for the Talkback signal.
When using the low latency mixer, note that the Talkback signal is routed through the
selected Playback mixer channel.

9. Keyboard Volume - The audio system may be configured so that the Mac keyboard
volume controls set the output level of Element’s speaker or headphone outputs.

Playback 1-2

Speaker

11
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Device Sidebar

The Device Sidebar provides settings that are specific to the Element interface connected to the Mac.

1. Device ID - Identifies the hardware connected to the Mac system.
e Clicking this button causes the displayed hardware to flash it's status light for three
seconds.

Element46

2. Main Output Format - Changes the output to suit what is being connected to the XLR Main

Speaker .
output jacks:
e Speaker - Use this setting when connecting speakers to the Main XLR hardware
+4dBu outputs

e Line - Use this setting when connecting a mixer or other device with its own volume
control to the Main XLR hardware outputs

Main Output Level - Selects the line-level reference for the XLR Main output jacks:
e Choose +4dBu when connecting to “pro” gear with inputs at a +4dBu nominal level.
e Choose -10dBV when connecting to “semi-pro”, hi-fi, or musical instrument gear with
inputs at a -10dBV nominal level.

ADAT/SMUX 3.

ADAT/SMUX

4. Optical In and Out Format - Sets the digital audio protocol for the optical connectors. Match
the optical format to that of the connecting device:

e SPDIF: The two-channel SPDIF audio format is transmitted or received through the
selected port’s In or Out connections. This format is capable of utilizing a maximum
sample rate of 96kHz.

e ADAT/SMUX: The multi-channel ADAT or SMUX format is transmitted or received
through the selected ports. Capable of 8 channels of digital I/O at sample rates
44 1kHz - 48kHz, and 4 channels of digital I/O at sample rates 88.2kHz - 96kHz.

- *On Element 88, setting the sample rate to 88.2kHz or 96kHz activates the second
set of optical I/O. This provides 4 more channels for a total of 8 channels of digital I/0.

5. Analog In-Optical Out - Enable direct routing from Analog inputs to Optical outputs. When checked, all analog inputs
are passed individually to the Optical outputs.
- On Element 24, signal only appears on ADAT output 1-2.
- On Element 46, signal only appears on ADAT output 1-4.
- On Element 88, signal appears on all ADAT output channels.
Note: When Optical Out Format is set to SPDIF, only inputs 1-2 are transmitted to the optical output 1-2.

Multiple Element Device Sidebar
When multiple Element Devices are in use, the Device Sidebar changes to show the Output Format and
Output Level of both devices, while reflecting the loss of the Optical options:

12
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Channel Section

This portion of the Primary Window displays Channels for Analog input, Digital input, and Playback from audio software.

Analog 2 Analog 3 Analog 4 Optical 1-2 ~ Optical 34  Playback 1-2  Playback 3-4

. ®

5 Mic Mic Instrument

OMONO
J-1- -
o @ - H o

1. Channel Top Label - Indicates the channels source. Can be renamed by clicking the label and typing a
user-customized label. To restore to the default text, delete the text and press “Return” on your keyboard.
*These labels are transmitted to your DAW

2. Channel View Button - Show the Channel View pop-up to view/hide various ¢ i ¢
Channels‘ Analog IN Digital IN .Playback |
* Channels are disabled when hidden so audio signal will not pass.
e Analog Input Channels - Corresponds to the physical analog input
connections on your Element interface.
e Optical Input Channels - Corresponds to the physical optical input
connections on your Element interface.
e Playback Channels - Corresponds to the virtual signal path from your Mac’s software outputs.

3. Input Channel Level Meter - Shows the post-gain digital signal level coming into the channel.
4. Input Icon - Shows the input type selected from the Analog Level drop-down

5. Analog Level - Use this drop down menu to choose the analog level for each A/D conversion channel.

e Choose Mic when connecting microphones or direct boxes, or any devices that needs to run through a
microphone preamplifier. -XLR Input only

e Choose Inst when connecting a guitar or keyboard, or any high impedance (Hi-Z) instrument to the 1/4” input
(balanced TRS or unbalanced TS). The signal is sent through a Hi-Z to Low-Z conversion circuit before sent
through the microphone preamplifier circuit.

e Choose +4dBu when connecting to “pro” gear, such as en external mic pre, compressor, or EQ, with outputs
at a +4dBu nominal level.

e Choose -10dBV when connecting to “semi-pro”, hi-fi, or musical instrument gear with outputs at a -10 dBV
nominal level.

6. Gain Control - Use to adjust the gain of the microphone preamp. Not available when the input is set to +4dBu or
-10dBV

13
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7. Input Settings - Provides options for the various inputs:

AR
° I: : Use this button to enable 48 volt phantom power on the corresponding Analog In channel. Condenser
mics require 48 volt phantom power to operate.

G
° E-Group: The input gain controls of adjacent odd-even channels are adjusted simultaneously. Any level

offsets that exists before inputs are grouped will be preserved after a group is chosen.
=

8L
° Soft Limit: Select “On” to engage. This option begins to attenuate transient peaks at a threshold of

-4dBfs.

a
° E Polarity Invert: Use this button to invert the polarity of the input signal.

Apple Keyboard Navigation Tips

Use the Arrow keys to change Analog input and output
settings;

Press < > to scroll the orange
focus ring through analog inputs and

I \ 1| outputs.

Press AV to raise or lower the
level highlighted with the focus ring.

a

.

Use the volume keys (F10, F11 and F12) to set the level of
the Speaker or Headphone output.

EBER ER

14
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Mixer Section

The mixer section provides several Direct Monitor mixers, and a special FX Send mixer for workflows that utilize the
low-latency Direct Monitoring features of your Element Thunderbolt interface.

1. Mixer 1 - Signal from each channel can be sent through
this mixer by raising the corresponding Mixer 1 Channel
Fader.

e This mixer's Master signal can then be selected as a
source for the Headphones or Speaker outputs,
providing a low-latency direct monitoring signal path.

e This mixer can also be sent back into the computer as
a separate stereo input available in your DAW.

e The faders on this mixer affect the fader send signal
of the other Mixers and FX Send when the Pre Fader
button is not engaged.

2. Mixers 2, 3, 4 - Signal from each channel can be sent
through these mixers by raising the individual Mixer 2, 3,
or 4 Channel Fader.

e This mixer's Master signal can then be selected as a
source for the Headphones or Speaker outputs
providing a low-latency direct monitoring signal path.

*Note:

Element 24 = 2 mixers available

Element 46 = 3 mixers available

Element 88 = 4 mixers available

3. FX Send - Signal from each channels can be sent through
this mixer by raising the individual FX Send Channel
Fader.

e This Mixer is sent back into the computer where it
shows up as an extra stereo input available in your
DAW. By using this input on an Aux track that has a
Reverb or Delay or other effects plugin, effects can be
applied to a Direct Monitoring situation which would
otherwise be completely dry of effects.

Master

4. Pre Fader Button
e When engaged, the channel signal from the mixer 2, 3, or FX Send mixer is sent to that mixer's Master fader
based only on that mixer’s channel fader level. This signal level is not affected by the position of the Mixer 1
fader (Pre-fader).
e When not engaged (Post-fader), the channel signal from this mixer will change based on the Mixer 1 fader
position. In other words, moving the Mixer 1 fader on this same channel will alter the signal level going to the
mixer 2, 3 or FX Send mixer master.

5. Mixer View buttons - View or Hide mixers using this button.
*Mixers are always ACTIVE. A mix will continue working even when hidden.

6. Channel Fader - Set the level of the channel signal in the mixer master stereo output.
7. Mixer Channel Pan Control - Set the left-right placement of the channel signal in the mixer master stereo output.

e  Option-click to reset the pan to center (0) or Option+Command-click to set all pans in that mixer to center (0).

8. Channel Mute button - Cut the signal routing to the mixer stereo output. Command-click to cut all channels

15
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9. Channel Solo button - Mute all channels that do not have this solo button engaged in this mixer. Command-click to
solo all channels.

Note: Engage Solo-Safe mode on a channel by Control-Clicking the Solo button on a channel. This prevents this
channel from being muted when another channel in the mixer has solo engaged.

H A solo-safe engaged track will display a colored “S” within the Solo button

10. Channel Mono/Stereo button - Set the channel for a mono or stereo signal path. When set to stereo, odd-even
adjacent channels are combined.
e To group input settings set each channel’s Input Gain to 0dB, push the Group button, and then set the channel to
Stereo.
e To adjust a stereo channels individual input’s settings, use the arrow buttons that appear next to the Analog

11. Channel Aux Label - This secondary label is a convenient way to enter session-specific information, such as the
performer whose input appears on the channel. This label is not transmitted to the audio software (DAW).

Monitor/Output Section

The Monitor/Output Section is where you select what you hear in the outputs, and control the volume of the various outputs.
The Output Level Meters are also a useful diagnostic tool to see if signal should be present at the various outputs.

HP1  HP2 Main .
1. Output Level Meters - Displayed the output level. Is not affected by the output level

=2 control.

M
3. Output Source Selector - Selects the sound source for each output. The options
Flayback 1-2 are:
) Playback - Sends a playback channel stereo signal directly to this output,
bypassing all mixers.
° Mix or FX Send - Send the stereo signal from this mixer’'s Master to this
output

2. Output Level Control - Set the listening level of the Main or Headphone outputs.

4. Output Mute button - Mutes the output
Playback 1-2

5.  Output Dim button - Reduces the output listening level by -15dB

HP2 £
6. Sum-To-Mono button - Collapse left and right signals to mono at the output. This

combined signal is sent through both Left and Right Outputs and is useful for
verifying the mono-compatibility of a stereo mix.

Flayback 1-2 3

2 4/

Main k

16
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Remote Window

The Remote window provides settings to configure the optional Apogee Control hardware remote control. To open the Remote
window, choose Window > Remote, type Command+4 or click on the Remote toolbar button.

Remote Control Assignments

1 2 3 4
Analog Input 48V Soft Limit Polarity
= EXeniom The nine buttons in the window - 1-4, A-D and Control Knob - are used to define the
A B c D function of corresponding hardware Function buttons.

Launch Mongo Set Main Out  Momentary
Elemant Speakers to Reference Talkback

Control Knob
Mute All
Outputs

The following functions are available for all buttons:

None - When a button is assigned to None, it does nothing.

Mute Panic

Mute Panic - Mute the headphone and Speaker outputs of all connected units.
- Tapping the button again doesn’t un-mute the signal - it must be un-muted
in Element Control software.
Mute Speakers - Mute the Main speaker output (when two interfaces are connected,
Master interface only).
Mute Headphones - Mute the Headphone outputs of all connected interfaces.
Mute All Outputs - Mute the Speaker and all Headphone outputs; tap again to unmute.
Mute Toggle Headphone/Speaker - Toggle between two states:
1. All Headphone outputs muted and the Speaker output unmuted
2. All Headphone outputs unmuted and the Speaker output muted.
- When recording in the same room as speakers, this function provides one
button switching between recording with headphones and listening back
over speakers.

Dim Speakers - Lower the Speaker output by 15dB (when two interfaces are connected,
Master interface only).

Dim Headphones - Lower the Headphone outputs of all connected interfaces by 15dB

Dim All Outputs - Lower the Speaker and all headphone outputs by 15dB

Mono Speakers - Sum the stereo Speaker output to mono (when two interfaces are
connected, Master interface only).

Mono Headphones - Sum the Headphone outputs of all connected interfaces to mono.

Mono All Outputs - Dim the Speaker and all Headphone outputs.

Toggle Speaker Sets - (Element 88 only) Toggle playback between the A and B Speaker
Sets, when Main Output Format (Device sidebar) is set to 2 Speaker Sets.

Set Main Out to Reference Level - Set the Main output level to a predetermined
reference level, from -64 to 0 dB. To determine the reference level, use an Launch Element Contral
external audio measurement tool and set the Main Out control to generate
the desired SPL level. Once Main Out is set, then assign a Function button to “Set Main Out to Reference
Level”. Now, when that button is pushed, Main Out jumps to the saved level.

17
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Clear Meters - Clear held peak and overs from Element Control software level meters.
Toggle Talkback - Turn the Talkback function on indefinitely until the button is tapped a

second time to turn it off. Mute Panic

M

Momentary Talkback - Turn the Talkback function on only when the button is held e
ute

down. Releasing the button turns Talkback off.

Mute Toggle Headphone/Speaker

Analog Input Level - Toggle through an input’'s Analog Level settings (+4 dBu, -10 dBV,
Mic, Instrument) when that input is selected for control. If the Headphone
or Speaker output is selected for control and a button assigned to Analog
Input Level is tapped, all LEDs flash for a moment to indicate an invalid
operation.

48V Phantom Power - Toggle 48V Phantom Power on/off for the input selected for
control

Group - Toggle Group on/off for the input selected for control
Soft Limit - Toggle Soft Limit on/off for the input selected for control
Polarity - Toggle Polarity Inversion on/off for the input selected for control

Select Input 1..8 - Select the designated input (1-8) for control. When two interfaces are
connected, use the Toggle Device setting to toggle between Interface A
1-8 and Interface B 1-8.

Toggle Device - Toggle the interface selected for control when two interfaces are
connected. By setting the 8 Function buttons to Select Input 1, Select
Input 2, etc and setting the Control Knob to Toggle Device, it's possible to
access both interfaces’ mic pre gain setting with only a few button taps.

Launch Element Control - Launch Element Control software or, if software is already
launched, bring the app into keyboard focus.

Launch Elemant Control

Mute All Outputs

18
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Hover Help Window

For specific information about Element Control’s features, open the Help window and hover your Mac’s pointer above each
setting to see a helpful summary.
Hover Help

Hover Help Window

Hover your cursor over Element Control
software features to see a helpful summary
in this window.

Menu Bar Menus

Element Control Menu

ST File View Window Help

+ About Element Control

Auto Launch

Preferences...

Hide Element Control 3H
Hide Others EH
Show All

Analog 4

Quit Element Control 3¥Q

About Element Control - Choose this menu item to display version information
for all hardware connected and software elements installed on your Mac.
Preferences > Auto Launch - Choose this menu item to launch Element Control
when an Element Thunderbolt interface is connected to the computer.

Hide Element Control - Choose this menu item to hide the Maestro application
Hide Others - Choose this menu item to hide all other open applications

Show All - If any open applications have been hidden, choose this menu

item to reveal all open applications

Quit Element Control - Choose this menu item to quit Element Control

File Menu

m View Window Help
Open Snapshot #O
Open Snapshot Template ##T
Save... dh o
Save As {+3S

Open Snapshot - Choose this menu item to open a user-saved snapshot template file on your computer.
Open Snapshot Template - Choose this menu item to open the Snapshot Template Chooser window.
Save - Choose this menu item to save a user-customized Snapshot file to a location on your computer.

Save As - Choose this menu item to save a customized Snapshot file in a new name or new location on your computer.
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View Menu

System Settings - Choose this menu item to open the System Settings sidebar
Device Settings - Choose this menu item to open the Device Settings sidebar
Enter Full Screen - Choose this menu item to expand Element Control to fill the display screen.

Window Menu

IS Help

Selecting an item in the Window Menu switches to a view of that selection.

Help Menu

Use the Search Field to search for a specific menu item.
Element Support Online - Select this menu item to be taken to the Apogee website’s Support page for Element.

20



Apogee Element Series User's Guide

Apogee Control iOS App

Many of the features and settings of the Apogee Element Thunderbolt interface can be controlled by the free Apogee Control
iOS app. Here’s how it works:

eseso ATAT LTE 12:29 AM 7eoimm| 1. Open the App Store app on your iPad, iPhone, or iPod Touch and search for
\ apogee control x Apogee Control.

| Apogee Control for Element

| Series Interfaces 2. Download and open the Apogee Control app and the “Connect to Device” screen
E | Apogee Electronics Corp WI” appear

®0000 ATRT T 12:47 AM

. . Connect to Device
3. Your Apogee Element interface will appear

in the “Available Interfaces” list if:
e YouriOS device & your Mac are
connected to the same WiFi network
e The Element Driver Software has been
installed on this Mac computer
e The Element Interface is powered on and
connected to your Mac computer Element24 Demo

Element46 Apogee's iMac

5. Select your Element Interface from the list of | Eatiattaduaid

Available Interfaces .

Apogee Control Connecting

5 @ Q ¢

Allow an Apoges Control connection from AudioSonic's iPhone
Search §37

| Allow L)

6. A message will appear on your Mac: Click Allow.

7. The main Control screen will appear. It is separated into three sections:
e Toolbar
e Analog Input settings
e  Monitor Output settings

iPhone iPad

00000 ATRT = 12:57 AM 10 [ecee )
o [Fecee | I“ Analog 1
Mic

Analog 1 Analog 2

Mic \.{ Mic

Analog 3 Analog 4

Main Mic Mic

Playback 1-2
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iOS App Toolbar

Preferences Clear meters Mute all outputs

Devices Talkback

Preferences - Opens the Preferences Menu
Prevent Screen Lock - When engaged, the iOS device’s screen will not
automatically turn off while the Control app is open.
Devices - Opens the Connect to Device Menu.
Clear meters - Clears any Peak Hold or Over Hold indicators on the level meters.
Talkback - Tap and hold to engage Momentary Talkback; release to disengage Momentary Talkback;
Double-tap to toggle Talkback on; tap again to toggle Talkback off.
Mute all outputs - Engages Mute on all speaker and headphones outputs. These mutes must be manually disengaged.

Prevent Screen Lock

Analog Input Settings

Provides options and controls related to the analog inputs of your Apogee Element Thunderbolt Interface

Input Source
- Mic - XLR input is sent through the microphone preamp Analog 1
- Instrument - %2 input is sent through a Hi-Z to Low-Z circuit then to the
microphone preamp
- +4dBu/-10dBYV - Live level signal from XLR input bypasses preamp
circuit
Gain - Drag your finger up or down on the gain circle to adjust the Input Gain

Analog 2

Mic

48V - Toggles phantom power on/off

G - Group the input gain controls of adjacent odd-even channels

IE1[E]

SL - Soft Limit attenuates transient peaks of the analog input at a
threshold of -4dBfs before the signal is sent to the A/D converter.

- Inverts the input signal’s polarity
Input Icon - The icon provides visual indication of the type of Input Source selected
Input Level Meter - Shows the input signal strength after going through the preamp circuit.

Navigation
- Use your finger to swipe left or right to page to additional analog inputs
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Monitor Output Settings

Provides option and controls related to the Main and Headphones outputs of your Apogee Element Thunderbolt interface.

Output Source Selector - Selects the sound source for this output. The
options are:
Playback - Sends a playback channel stereo signal directly to this
output, bypassing all mixers.
Mix or FX Send - Send the stereo signal from this mixer's Master to
this output

VE

Output Mute button - Mutes the output

Output Dim button - Reduces the output listening level by -15dB
Sum-To-Mono button - Collapse left and right signals to mono at the output. Playback 1-2
This combined signal is sent through both Left and Right Outputs and is
useful for verifying the mono-compatibility of a stereo mix.

Output Level Meters - Displayed the output level. Is not affected by the output level control.
Output Level Control - Set the listening level of the hardware output.

Navigation
- Use your finger to swipe left or right to page to additional analog outputs
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Snapshots & Examples

When Element Control software is first opened, you are presented with a Snapshot Template chooser.

@ Snapshot Templates

Apogee Element Control
Choose a Template to get started

Full Functionality

This template sets up Element Control for Direct Monitoring.

nnels are routed directly to hardware outputs through

The following section will explain and explore these default Snapshot Templates in depth, with use-cases demonstrating how
each would be used in with a recording program (DAW) like Logic Pro X.
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Getting Started Snapshot Template

This Snapshot Template provides simple input settings in the Input Channel section, a single stereo playback channel for
audio playing from audio software such as iTunes or your DAW, and output settings for dealing with your speaker and
headphone outputs. This represents the most common and familiar use of an audio interface.

Analog 1 Analog 2 Analog 8 Analog 4

Hover Help

Hover Help Window

Hover your cursor over Element Control
software features to see a helpful summary
in this window.

This template provides:
Primary Window -

e All Analog Input Channels - Provides settings for adjusting & controlling the analog inputs as well as input level
meters to show the strength of incoming signal.

e One Playback Channel - For audio signal being played from an audio application on your Mac.

o No Mixer Section - Mixers are hidden in this Snapshot. Use of the Mixers will be explained later in this guide.
Monitor Section - Provides settings & controls for headphones and speaker outputs. You can choose the sound
source for each output allowing some sounds to come through some outputs and other sounds to come out of other
outputs.

Essentials Window - Provides the same settings and controls as the Analog Input Channels and Monitor Section.
Hover Help - Hover your Mac’s pointer above each setting of Element Control software to see a helpful summary.

Each of these sections dictate how and where audio signal flows between the Element Thunderbolt Interface’s hardware
connections and the recording software (DAW) tracks and channels on your computer. Lets analyze that signal flow:
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How Element Control Input Channels appear in your Recording Program:

Stwred Out

Sherpes OhA

S Out

The Analog Input Channels of Element Control allow
you to select the type of input you are using: Mic,
Instrument, or Line Level +4dBu/-10dBV.

You may activate phantom power (48V) for condenser
mics, Group (G) channels together in stereo pairs, turn
on Soft-Limit (SL), or invert the polarity () of any of
these input channels.

In your recording program, any audio track you create
can be set to record these Analog Inputs.

In this example Logic Pro X project, four audio tracks
have been created with each track set to Input 1, 2, 3,
and 4 respectively. In this way, each Element 46
interface audio Input Channel corresponds with the
four tracks created in Logic Pro X.

You can think of your audio signal as flowing from the
analog inputs of your Element interface, through the
Element Control software’s Analog Input Channels,
then into the Logic software.

Note: With the Audio Device control feature in Logic
Pro, you can see that the settings made on these Input
Channels in Element Control are matched/mirrored by
the Audio Device section of the Logic Pro X mixer.

The audio signal then flows through these Logic tracks
until it eventually exits through the Logic Output

channels.

From there the signal flows back into the Element
Control software:

26



Apogee Element Series User's Guide

How Element Control Outputs work with your Recording Program:

Edit Options View

Stereo Out Stereo Qut

Read Read

3 M 5

Audio 1 Audio 2

Instrument

@
L\
W

Single = Tracks  All

Stereo Out Stereo Out

Read Read

e

I R
M s

Audio 3 Audio 4 Stere® Out

Analog 4 Playback 1-2

M D

Master

Signal from the Stereo Output of Logic
Pro X appears in Element Control’s
Playback 1-2 channel.

This Playback 1-2 signal will flow to the
Element interface’s outputs because the
audio source for the Headphone and
Main speaker outputs is set to Playback
1-2.

In this way, the same signal is played

from all of the Element Thunderbolt
analog audio outputs.
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How to get a separate mix to the headphones than from the speaker outputs:

To do this, you first have to create an aux mix in your Recording Program.

O Analgl

M

Audio 1

Anglog 1

0
s

Analog IN

M

Audio 2

Analog 2

!

Digftal IN

& Analg4 O Busi

In Logic, create a Send to a Bus on one of your
tracks @

ut |3 Plabka/a

This automatically creates an Aux track in your
Logic Pro X Mixer @

- In Pro Tools and other DAW’s you must
manually create an Aux Track

Set this Aux track to output via Playback 3-4 @ .

M s M s M 5 M

Audio 3 Audio 4 2 Auxt Stereo Out Qutput 3-4

Analog 3 Anglogd  Playback 1-2  Playback 3-4
3 4
T

Playback Next, go to Element Control and click Channel View @ .

Click Playback 3-4 to show that playback channel & .
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Audio 1

M

Audio 2

Anslog 1

Analog 2

Audio 4

Analog 8

Anslog 4

M

M D

Master

Apogee Element Series User's Guide

Set the Headphones output to Playback 3-4

to send this signal to your headphones
output.

The Main monitor outputs are still set to
Playback 1-2 and play audio from Logic’s
Stereo Out master track.
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Essentials Snapshot Template

This Snapshot Template is the same as the Getting Started Snapshot Template but only the Essentials Window is displayed.
This represents the simplest layout of the Element Control software. It provides controls for only Inputs and Outputs. All other

settings are disabled or hidden:

All Analog Input Channels and Monitor output controls are represented in the Essentials bar. The small buttons below the Gain
controls correspond to the Input Settings 48V, G, SL, and . The buttons under the Output Volume controls correspond to the

output buttons M, D and %.

For convenience, the Essentials bar can be converted to a vertical orientation via the Orientation Button. In this way, the
Essentials bar can be placed next to your DAW software for easy access.

@& LogicProX File Edit Track Navigate Record Mix View Window 1 Help

@ LogicProX File Edit Track Navigate Record Mix View

Eementas i
0 =0 ¥ % 20 2 2132 120 Cmay
Y T
G

Audio 1
mM's R
Audio 2

m's A

Audio 3
ms! @I

Audio 1
mM's R’

Audio 2
mMs ®

Audio 3
ms |l
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Direct Monitoring Snapshot Template

This Snapshot Template is perfect for users who do not want to open a DAW in order to listen to their inputs. It does this by
setting the headphones and speaker outputs to “Mix 1”. In this way, any channel that has the Mixer 1 fader raised will be
heard. This snapshot is also for users who want the lowest latency monitoring possible, and can’t achieve a low enough buffer
in their DAW for software monitoring to be acceptable.

Playback 1-2

Master

This template provides:
e All Analog Input Channels - Provides settings for adjusting & controlling the analog inputs as well as input level
meters to show the strength of incoming signal.
e One Playback Channel - For audio signal being played from an audio application on your Mac.
e Mixer 1 Showing - Mixer 1 is the key to direct monitoring and is used to send signal from the various input channels
directly to the Monitor Section.
e Monitor Section - All the main and headphone outputs are set to Mix 1.

31



Apogee Element Series User's Guide

Let’s analyze the signal flow:

Mastar

Any signal from the Input Channel Section must go through the Mixer 1 fader before it will be heard in the outputs that are set
to “Mix 1”. This has a few benefits:

e An analog or digital input can be heard directly through the interface rather than having to setup an audio track with
software monitoring in a recording program first.
Provides a very low-latency monitoring path.

Direct input signals can be mixed with audio from Playback channels such as your recording program or iTunes or
YouTube, etc.

Note that signal from the Input Channels go to your recording software (DAW) at the same time they are being sent to the
Mixer 1. In this way, this Direct Monitoring Snapshot can be used with a DAW that is unable to achieve a low enough buffer

size to get the latency delay to be acceptable. Here’s how you would set up this Snapshot Template with a recording program
like Logic:
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Using the Direct Monitor Snapshot Template with your Recording Program

1. Setup an audio track in Logic.
- Make sure input monitoring on that track is turned off because you are direct monitoring through Element
Control instead.
Record to that track.
Setup a second audio track in Logic that also has input monitoring turned off.
Record the second track. You will be able to hear the first track as you record.
Adjust the Mixer 1 channel faders to control the volume of direct input you are recording vs playback of already
existing recording playing back from Logic.

o krobd

The signal flow would look like this:

Aralog 4 Playback 12

Stareo Out  Stereo Out

Input signal from Analog 1 is sent to both Logic and the Mixer 1

In Logic, the signal is routed to an Audio track for recording. Input Monitoring on this track is off.

Playback from Logic is sent to Element Control’s Playback 1-2 Input Channel.

Both the direct signal from Analog 1 Input channel, and Playback 1-2 Input Channel are mixed together to the Mixer 1
Master.

5. Mixer 1 feeds the Main and Headphones outputs.

Pobd-=

This same Snapshot Template can be used in other recording programs like Pro Tools, Cubase, Ableton Live, etc. by using
the same principles shown in this example.
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Full Functionality Snapshot Template

For the user that wants a “god-view”, this Snapshot Template has all side-panels, mixers, and channels visible.
Note: All outputs are set to “Mix 1” in this Snapshot like the Direct Monitoring Snapshot Template. Therefore you must raise

the Mixer 1 channel faders to hear anything in the outputs.
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Vocal Overdub Snapshot Template

This Snapshot Template is conceived for an overdubbing recording session. At this stage in the recording process, a recording
project is typically full of tracks and plugins which may require your |/O Buffer to be set to a large size. Because software input
monitoring with such a large buffer would result in too much latency, this snapshot is designed for Direct Monitoring a single
input, but using Element Control's FX Send to apply your DAW’s reverb to the Low Latency (Direct Monitoring) mixer inputs.

Notice that in this Snapshot Template:
- The Mixer 1 and FX Send are both displayed
- The Outputs are set to “Mix 1” for direct monitoring
- There is a single analog input channel active, and two playback
input channels active.

Analog1  Playback1-2  Playback 3-4

Here’s how this is set up using Logic Pro X:
1. In Logic Pro X > Preferences > Audio > General, uncheck the
boxes for “Software Monitoring” and “Input monitoring only for
focused track, and record-enabled tracks”

Devices General Editing /O Assig

& Display audio engine overload message

Recording File Type:  AIFF

& 24-Bit Record ing

Software Monitoring

Input monitoring only for rack, and record-enabled tracks

Independent monitoring cord-enabled channel strips

2. Create an Audio track. Set the input to Analog 1.

L]
2 eo@lelv s m 1120 Cmy Y4

Region: MIDI Thru Edit v | Functions

Track: Audio 1 +

Note: For the purposes of this guide, having the
e Mixer visible will make things easier. To do this:
e Go to the View Menu > Show Mixer.

Window 1 Help

1

Show Library Y
Hide Inspector |

Show Smart Controls B
Show Editor E
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Setup a standard reverb send and return for this audio track:

3. Inthe “Sends” section of the Audio track, create a Bus send.

Set the Bus level to 0.0dB.

When you create the Bus send, Logic will automatically create an Aux track with
that bus selected as the input.

Note: You will need to manually create the Aux track in other DAW’s like
G Pro Tools, Cubase, Live, efc.
M

Audio 1 Stereo Out

4. Inthe new Aux input track, instantiate your favorite reverb plugin.

Raise the Aux 1 channel fader to
0.0dB.

Analgl

3
3
>
»
»
4
3
3
»
4
»
3
3

Designer

M s M

Audio 1 Aux 1 Sterec Out
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5.

In the mixer view’s Option’s menu, create a New 6.
Auxiliary Channel Strip.

Stereo Out

&

IR L B
M s n s M s M

Audio 1 Aux 2 Stereo Out

Apogee Element Series User's Guide

Set this new Aux 2 channel’s input to the FX Send
L/R (Input 15-16 in this example)

Read

Set the Aux 2 channel to “No Output” (or lower the fader), and create a bus send to the same bus as the Audio track.

Analg1

Lain

Bus 1 (Aux 1)
Bi

I"\fR
M

Audio 1 Sterec Out

Set the Bus level to 0.0dB.

10. In Element Control, raise the FX Send
fader for the Analog 1 channel to 0.0dB
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At the end, your Logic Project will look like this:

Region: MIDI Thru

Track: Audio 1

Audio 1

This creates a dual-path signal flow: e
e Path 1 happens when Recording

e Path 2 happens when Playing back that

recording dit Opt Single | Tracks

Path 1:
Audio from Element Control Analog 1 input is sent to
Logic’s Audio 1 track for recording.

This Analog 1 Input signal also goes via the FX Send to
Logic Aux 2 input, which then Bus sends to the Aux with
the Reverb plugin.

The Reverb Aux output is routed to the stereo output of
the Logic session which returns to the Element Control
mixer via Playback 1-2.

Element Control Mixer 1 combines the Analog 1 signal
with the reverb from Playback 1-2 and the mix of these
is sent to the Main and Headphone outputs.

M D

Master

Path 2:
When playing back the recording in Logic’s Audio track 1, the Bus 1 Send on this track sends the signal to the Aux with the
Reverb Plugin applied.

This Audio playback track and Reverb Aux track is mixed in Logic’s Mixer and sent to the Stereo Out, where it arrives in
Element Control via Playback 1-2.

Element Control Mixer 1 then sends the Playback 1-2 signal on to the Main and Headphone outputs.

For both Path 1 & 2:

e Since the bus send level to the Reverb plugin in Logic is the same for recording and playback, the reverb sound
doesn’t change from recording to playback.

e Adjust the Bus 1 sends for a proper level to the Reverb Aux track, then adjust the Reverb Aux track fader until the
desired amount of reverb is heard.
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A/D Expander Snapshot Template

This Snapshot Template facilitates the use of your Element Firewire interface as a simple Analog to Digital Converter (A/D).
This snapshot is useful when wanting to send digital audio to a Digital Mixer, or separate Audio Interface. In this way, you can
utilize the excellent Apogee Preamps and Converters through another digital audio system.

The Individual Analog inputs are sent directly to the ADAT optical outputs.
e Element 24 - Analog input 1 - 2 > ADAT outputch 1 -2

e Element 46 - Analog input 1 - 4 > ADAT outputch 1 -4
e Element 88 - Analog input 1 - 8 > ADAT outputch 1-8
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Working with a Multiple Element Interface Setup

The connection of any two Element Series interfaces is supported in any desired order, for a system with up to 16 analog
inputs, 8 line outputs, and 4 headphone outputs.

Connecting a Multiple Element Interface System:

To connect multiple Element interfaces:

e A Mac with at least two Thunderbolt ports is required

Element interfaces may be connected directly to your Mac or after dual-port Thunderbolt peripherals
The Optical I/0 of both interfaces is used for digital clocking and audio signal bussing between the interface’s low

latency (direct) monitoring mixers. Thus, Optical I/O is not available for external connections in a Multiple Element
Interface System

g

&= | 5 |
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The Multiple Element Interface System in Use

When a Multiple Element Interface System is first powered up, one of the two interfaces is designated at random to be the
Master interface. The Master’s front panel LED light will be green while the Slave’s front panel LED light will be blue (if the
Slave interface LED is flashing red, check that optical cables are connected as shown above).

Note that only the Master interface has these attributes:
e  System clock master
e  Main outputs configurable for connection to speakers
e Inputs listed first in DAW input lists.

To change the Master device, open the System sidebar, then change the designated interface in the Master Device dropdown.
Inputs and outputs of the two Element interfaces are aggregated in the Apogee Thunderbolt driver, so that both interfaces
appear as one audio device named Apogee Thunderbolt in your DAW or in OS X System Sound Preferences. To distinguish

inputs for each interface, Master input labels include the prefix A, Slave input labels include the prefix B.

Likewise, Element Control Input settings, Low Latency mixer channels, and Main/Headphone output controls are labelled with
A and B prefixes to distinguish Master and Slave software controls.

Once two Element interfaces have been connected, Element Control retains data from both, even if one of the interfaces is
later disconnected. This means that even if one interface is missing, the 1/0 detected by your DAW and OS X remains

consistent, plus all previously saved Snapshots remain compatible.

Disconnected interfaces appear as “offline” devices; all settings in Element Control pertaining to an offline device appear in a
greyed out state.

Device

Element88

Speaker

+4dBu

+4dBu

To permanently delete an offline device, open the Device sidebar and click on the Trashcan icon at the
bottom of the offline device’s settings.
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Additional Support

For more information

e Apogee KnowledgeBase and FAQs

e Informational Videos

e Apogee Product Registration

e How to contact Apogee Technical Support
Please visit:

www.apogeedigital.com/support

Apogee Element Series User's Guide
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Specifications

System Requirements
Mac OS:

Apogee Element Series User's Guide

Compatible Software:

e Computer: Thunderbolt™ equipped Mac (iMac, e Any Mac Core Audio Com.patible application
Mac Mini, Macbook, Macbook Pro, Macbook Air, e Recommended apps: Logic Pro, Pro Tools, Ableton
Mac Pro) Live, Garageband, MainStage, Final Cut Pro, Digital

*Thunderbolt cable not included

Memory: 4GB RAM minimum, 8GB recommended Performer, Studio One, Cubase and Nuendo
OS: 10.10 or greater

Connection: Any available Thunderbolt™ port*

Power: DC Power supply included

Preamps, Inputs, and Outputs

Mic Preamps

Gain: Up to 75 dB and advanced stepped gain circuit design

Selectable 48v phantom power, hi-pass filter, Soft Limit and polarity invert
EIN: 129dB (un-weighted) @ 60dB, 150 Ohm input

Max input level: +20dBu

Input impedance: 3K Ohm

A/D Conversion:

Max input level (+4dBu ref/Mic): +20dBu

Max input level (-10dBV ref): +6dBV

Input impedance: 5KOhm

Freq resp 10 Hz -20Khz: > +/-0.2dB (@44.1Khz)
Rel. THD + N: -110dB

Dyn. Range: 119dB (A-weighted)

D/A Conversion:

Max output level (+4dBu ref): +20dBu
Max output level (-10dBV ref): +6dBV
Line output impedance: 90 Ohm
Freq resp 10Hz -20 Khz: > +/- 0.05dB (@44.1Khz)
Rel. THD+N : -114dB
Dyn Range: 123dB (A-weighted)
Headphone Max output level:
e 560mW into 30 Ohm
e 90mW into 600 Ohm
Headphone THD+N: -107 dB with 600 Ohm load @ 19 dBu
Headphone Dyn Range: 117dB a-weighted

Weights and Dimensions

Element 24

9.75"x5.5" X 1.75"
24.5cm x 14cm X 4.5cm
2.5lbs

1.14kg

Element 46

11.5"x5.5"x 1.75"
29.5cm x 14cm x 4.5¢cm
2.95lbs

1.34kg

Element 88

13.5"x5.5" X 1.75"
35cm x 14cm X 4.5cm
3.5lbs

1.6kg
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Warranty Information and Legal Notices

APOGEE ELECTRONICS CORPORATION warrants this product to be free of defects in material and manufacture under
normal use for a period of 12 months. The term of this warranty begins on the date of sale to the purchaser from an authorized
Apogee dealer (proof of purchase in the form of a receipt may be required). Units returned for warranty repair to Apogee or an
authorized Apogee warranty repair facility will be repaired or replaced with a functional equivalent product that is new or
refurbished at the manufacturer’s option, free of charge. Please note this guarantee may be subject to other conditions as
dictated by the customer’s legal warranty rights under the applicable national legislation governing the sale of consumer
goods.

Apogee reserves the right to change or improve design at any time without prior notification. Design changes are not
implemented retroactively, and the incorporation of design changes into future units does not imply the availability of an
upgrade to existing units. This warranty is void if Apogee determines, in its sole business judgment, the defect to be the result
of abuse, neglect, alteration or attempted repair by unauthorized personnel. The buyer acknowledges and agrees that in no
event shall the company be held liable for any special, indirect, incidental or consequential damages, or for injury, loss or
damage sustained by any person or property, that may result from this product failing to operate correctly at any time.

Warranty details are subject to change. For the latest warranty information please visit www.apogeedigital.com.

Declarations of Conformity

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:

(1) This device may not cause harmful interference and (2) This device must accept any

interference received, including interference that may cause undesired operation. This

equipment has been tested and found to comply with the limits of a Class B digital device, pursuant to Part 15 of the FCC
Rules.

CAUTION: Changes or modifications not expressly approved by Apogee Electronics
Corporation compliance could void the user’s authority to operate the equipment.

Rating: 5V 400mA USB 2.0

Industry Canada Notice

This Class B digital apparatus meets all requirements of the Canadian

Interference-Causing Equipment Regulations. Cet appareil numérique de la classe B respecte toutes les exigences du
Réglement sur le matérial brouilleur du Canada.

Declaration of Conformity — CE
Apogee Electronics Corporation hereby declares that the products, Element 24, Element 46, Element 88 and Apogee Control,
to which this declaration relates, are in material conformity with the following standards or other normative documents:

(EN50081-1/EN55022; 1995) and (EN50082-1/IEC 801-2, 3, 4; 1992)
following the provisions of: (73/23/EEC — Low Voltage Directive)and (89/336/EEC — EMC Directive)

Declaration of Conformity — CE

Apogee Electronics Corporation hereby declares that the products, Element 24, Element 46, Element 88 and Apogee Control,
to which this declaration relates, are in material conformity with the following standards or other

normative documents:
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(EN50081-1/EN55022; 1995) and (EN50082-1/IEC 801-2, 3, 4; 1992)
following the provisions of: (73/23/EEC — Low Voltage Directive)
and (89/336/EEC — EMC Directive)

Declaration of Conformity — Japan Apogee Electronics Corporation hereby declares that Element 24, Element 46, Element 88
and Apogee Control, to which this declaration relates, are in material conformity with the VCCI Class A standard.

Declaration of Conformity — Australia

Apogee Electronics Corporation hereby declares that Element 24, Element 46, Element 88 and Apogee Control are in material
conformity with AN/NZS standard requirements.
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